





















ModelSim Guide

CPR E 281: Digital Logic
[bookmark: _GoBack]
[bookmark: Introduction][bookmark: _bookmark0]Introduction
ModelSim is a software for simulating hardware related tasks such as those normally performed on the Altera FPGA Board. Due to the coronavirus pandemic we are not allowed to use these boards this semester, because they cannot be easily disinfected after each use. Therefore, we will use ModelSim to simulate our circuit designs.

[bookmark: Starting_ModelSim][bookmark: _bookmark1]Starting ModelSim
VDI provides a virtual Windows 10 or Linux desktop with the same software as our physical computer labs. VDI works both on-campus and off-campus and can be used from almost any computing device (https://etg.ece.iastate.edu/vdi/).

[bookmark: How_to_Connect_to_VDI][bookmark: _bookmark2]How to Connect to VDI
If you are off campus you no longer need to connect to the VPN before using VDI (unless you want to; instructions for VPN are posted here: https://vpn.iastate.edu/).

1. Download the client for Windows or Mac: https://vlab.ece.iastate.edu/
2. Install the client with all the defaults.
3. Launch the VMware Horizon Client
4. Click the New Server icon on the Horizon Client Home window (the plus button on the top left), enter https://vlab.ece.iastate.edu for the name of the Connection Server, and click Connect.
5. Enter your IASTATE NetID in the form of netid@iastate.edu and password
6. Double click on the CPRE Labs Physical or CPRE Labs Virtual (See image below). Do not use EE Labs Physical or Virtual as they do not have the correct software installed.
[image: ]

You should now be able to access Quartus Prime remotely, as well as your U: drive. When you are finished using the VDI session, make sure anything that you want to keep saved on your U: drive. Otherwise, it will be deleted after you logout. You can exit the VDI session via several methods:

1. Start Menu > Log off
2. Start Menu > Shut Down
3. Quit the VMware View Client

All sessions are automatically destroyed after 2 hours of inactivity or logoff/shutdown.

To open ModelSim, simply search for ModelSim on the start menu as shown in Figure 1.


[bookmark: Figure_1:_Starting_ModelSIM_from_the_sta][bookmark: _bookmark3]Figure 1: Starting ModelSIM from the start menu.

[bookmark: Creating_a_New_Project][bookmark: _bookmark4]
Creating a New Project
[image: A screenshot of a social media post  Description automatically generated]After starting ModelSim, click on File > New > Project and select a directory on your U: drive for the project as shown in Figure 2 and Figure 3. This directory will contain all files for the new project.




















Figure 2: Selecting a directory for a new project.


[image: A screenshot of a social media post

Description automatically generated]
[bookmark: Figures_2-3:_Selecting_a_directory_for_a][bookmark: _bookmark5]Figure 3: Selecting a directory for a new project.

After completing these steps, ModelSim creates necessary project and preset files to later ease the process of opening projects and view previous simulation logs.

[bookmark: Adding_Files_to_ModelSim][bookmark: _bookmark6]Adding Files to ModelSim
The next step is to add files to the project. There are two options, either to create a new file within ModelSim’s built-in text editor or add an existing file from the directory. The choice is made with the pop-up window shown in Figure 4, which should show up automatically after creating a new project. The files that can be added here are  .v files, i.e., Verliog HDL files.

[bookmark: Figure_4:_Pop-up_window_to_select_file_a][bookmark: _bookmark7]Figure 4: Pop-up window to select file additions.
[bookmark: What_Are_Verilog_HDL_(.v)_Files?][bookmark: _bookmark8]What Are Verilog HDL (.v) Files?
ModelSim can simulate circuits described using a Hardware Description Language (HDL). In this class we will use a language called Verilog, or sometimes Verilog HDL. There are two ways to create a Verilog (.v) file:

1. Describe the functionality of the circuit directly in Verilog using a text editor (such as the one in ModelSim).
2. Create a block diagram file (.bdf) for the circuit using a software tool called Quartus. Then, convert the .bdf  file to a .v file so that it can be simulated with ModelSim.

This guide describes how to create a Verilog file in Quartus. 

[bookmark: Converting_a_Block_Diagram_File_using_Qu][bookmark: _bookmark9]Using Quartus to Convert a Block Diagram File to a Verilog HDL File
Using the start menu, search for Quartus and start the application as shown in Figure 5.


[bookmark: Figure_5:_starting_Quartus_from_the_star][bookmark: _bookmark10]Figure 5: Starting Quartus from the start menu.

Load the desired block diagram file (*.bdf) that you want to convert to a Verilog (*.v) file. Then, go to  File > Create/Update > Create HDL Design from Current File as shown in Figure 6. A pop-up window will prompt you for the format of the output file. Make sure to select “Verolog HDL”  as shown in Figure 7. Click OK and let Quartus do the remaining work. The resulting  *.v file is now in the same directory and is ready to be opened by ModelSim.


  Note: After converting the file it should be added to a project in ModelSim so that it can be 
  simulated (see the previous page).  

[bookmark: Figure_6:_Converting_BDF_to_.v][bookmark: _bookmark11]Figure 6: Converting a .bdf file to a .v file.


















[bookmark: Figure_7:_prompt_to_choose_desired_conve][bookmark: Testing][bookmark: _bookmark12][bookmark: _bookmark13]

Figure 7: Prompt for choosing the destination of the converted .v file.


[bookmark: Compiling_Files][bookmark: _bookmark14]Compiling Files
To compile a file, right click on the file name within the project directory and then Compile > Compile All (see Figure 8). If the compilation is successful, a green tick mark will appear in the status column for this file. 

[bookmark: Figure_8:_Compiling_files_in_ModelSim][bookmark: _bookmark15]Figure 8: Compiling files in ModelSim.

[bookmark: Starting_a_Simulation][bookmark: _bookmark16]Starting a Simulation
Before you proceed to this step, make sure that all files in your project are compiled successfully. This is necessary because there could be dependencies between the files.

To run the simulation click Simulate > Start Simulation as shown in Figure 9.  A pop-up window will prompt you to select the file that you want to simulate.  In the “Design” tab, look for an item called “work” and then click the “+” button that is immediately to its left (see Figure 10). This will show more files. Click on the file that you want to test and then click OK.

[bookmark: Figure_9:_Starting_a_simulation_in_Model][bookmark: _bookmark17]Figure 9: Starting a simulation in ModelSim.


[bookmark: Figure_10:_selecting_the_file_to_be_simu][bookmark: _bookmark18]Figure 10: Selecting the file to be simulated from the work directory.

[image: A picture containing screenshot

Description automatically generated]
[bookmark: Figure_11:_starting_a_simulation_and_inv][bookmark: _bookmark19]Figure 11: Starting a simulation and invoking the wave form diagram.


A simulation window should pop-up as shown in Figure 11. Double click the file name to show all input/signal/output variables. Then select all variable in the menu on the right and press “CTRL-W” to add waveforms. No actual wave forms should show up since the variables have no initial value yet. This is shown in Figure 12.


[bookmark: Figure_12:_Adding_variables_and_incorpor][bookmark: _bookmark20]Figure 12: Adding variables and incorporating them into the wave form.

[bookmark: Edge-Case_Testing][bookmark: _bookmark21]Edge-Case Testing
Now, it’s time to finally test the circuit! For this example, we will hard code (or force) the values of the input variables for this circuit. This next step is important! Click on the desired input variable and not on an output variable. Then, right click and choose Force as shown in Figure 13. This allows you to force a value for that input indefinitely, or at least until it is forced to another value manually. The default value of an input is 1’hz. This value is neither 1 or 0 and can cause erroneous outputs. Make sure to force any inputs that are not tied to another circuit.

Another way to test is to create a testbench (if you’re interested look up some YouTube tutorials on this subject), but that is out of the scope of this class. 

Note: 
· The syntax for the forcing a value is “<number of bits>’h<value in hex>.” For example, forcing a value of “4h’a” represents setting 4-bit number with the value of 1010 (or A16). To force a value of 1 or 0 set value to “1’h1” or “1’h0” respectively. 
[bookmark: Figure_13:_forcing_values_on_an_input][bookmark: _bookmark22]Figure 13: Forcing values for an input.

After completing all of these steps, it is time to see some results. There is a command prompt at the bottom that allows for typing in commands in ModelSim syntax.

Using these commands, we can quickly tell ModelSim to complete tasks, instead of looking for them in the dropdown menus. Please ensure that all input variables have a forced value before doing this step. On the command prompt type  “run 100”, which lets the wave form simulate edge cases for 100 ns. The output variable now shows an expected output. In this case, the output of 0 AND 0 is 0! This is shown in Figure 14.


























[bookmark: Figure_14:_Wave_form_showing_0_AND_0_whe][bookmark: _bookmark23]Figure 14: Wave form showing 0 AND 0 for which the output is 0.

[bookmark: Questions][bookmark: _bookmark24]Questions

If you have any questions or comments, please email your lab TA for further assistance.
image2.jpeg
Al

Best match

Modelsim
Desktop app.

Search suggestions
modelsim - See web res.
modelsim tel
modelsim 107
modelsim linux
modelsim quartus.
modelsim download

modelsim transcript

oo oo oo

modelsim ini file

P modelsim

24

=

M

Modelsim
e

Open

Run as administrator
Open fl ocation
Pinto Start

Pinto taskbar

Uninstall





image3.jpeg
Al

Best match

Modelsim
Desktop app.

Search suggestions
modelsim - See web res.
modelsim tel
modelsim 107
modelsim linux
modelsim quartus.
modelsim download

modelsim transcript

oo oo oo

modelsim ini file

P modelsim

24

=

M

Modelsim
e

Open

Run as administrator
Open fl ocation
Pinto Start

Pinto taskbar

Uninstall





image4.jpeg
™ ModelSim SE-64 20193 - o X
[ i viw Compie Simuiste Add by Toos Laout Bookmaks Window Help

Debug Archive...
Resuits Analysis Database...

SMODEL_TECH]../foatfnid
SMODEL TECH]..fiece_env
‘SMODEL TECH/. ffact
‘SMODEL TECH]..jmc2_ib
‘SMODEL TECH]..[mge_ams
SMODEL TECH]..avm
SMODEL TECH]..fovn-2.1.2
SMODEL TECH]../pa b
‘SMODEL TECH]. jrom
SMODEL TECH]. /upf b
SMODEL TECH]. Juvm-1.1d

Environment »

Page setup...
Print... $MODEL_TECH/..Josvwm
SMODEL TECH/. /sv_std
Propessce: SMODEL TECH..sh_ux01v Ib
Recent Drectores >} SHODELTECH). Ahdopt b
SMODEL TECH/. /ital2000
RecentProjects .
SMODEL TECH/. feee
SMODEL TECH/..fmodelsim_ib
SMODEL TECH]. fctd
oy SMODEL TECH..Jstd developersit
(-4l symopsys Lbrary  SMODEL TECH../synapsys
(- veriog Lbrary  $MODEL TECH../veriog
A Transcript Hal x|
[v 77 =
# Loading project lablstep2
¢ reading C:/Progran Files/modeltechéd_2019.3/winéd/. . /modelsin. int
pocesin> =

[<ioDeson Losded> o Corie>s





image5.png
M ModelSim SE-64 20

File Edit View Compile Simulate Add Library Tools Layout Bookmarks Window Help

ERAEL IR 1]

(o-AE[me  m|ozE

a8

| ot popesign vl || cobmtamtfnicoremme |

l# 7/ 18 U.5.C. section 1905.
# 7/

JModelsim>

re =
Vital2000 u::: M Create Project X
iece Lbrary rject Name
modelsm b Lrary oo
std Lbrary
std developersit  Library e
o ::: [0:/Documenta/CeRE261/Lab0L gy Browse..
foult Lirary Name ——
ozt |
‘Copy Settings From
eche4_2020.2/modelsim i Browse..
 Copy Lirary Mappings " Reference Lirary Mappings
ok | _cancel
FATransapt Ha x|
[¢ 77 1s prohibited from disclosure under the Trade Secrets Act, =

| <No Design Loaded:





image6.png
M Add tems to the Project x
on the con to additems o that type:

0 0

M i





image7.png
M Add tems to the Project x
on the con to additems o that type:

0 0

M i





image8.png
Al Apps  Documents

Best match

S

Apps

Quartus (Quartus Prime 18.1)
Desktop app.

* Programmer (Quartus Prime 18.1)

“ Design Space Explorer Il (Quartus
Prime 18.1)

= Nios Il Software Build Tools for
Eclipse (Quartus Prime 18.1)

EDA Simulation Library Compile
(Quartus Prime 18.1)r

Search suggestions

P quartus - See web res
£ Quartus - Song

£ quartus download
Documents

Nios Il Documentation (Quartus

D i

Web

More \/

S = )

Feedback

Quartus (Quartus Prime 18.1)

Desktop app

Open
Run as administrator
Open file location
Pin to Start

Pin to taskbar

Uninstall




image9.png
Al Apps  Documents

Best match

S

Apps

Quartus (Quartus Prime 18.1)
Desktop app.

* Programmer (Quartus Prime 18.1)

“ Design Space Explorer Il (Quartus
Prime 18.1)

= Nios Il Software Build Tools for
Eclipse (Quartus Prime 18.1)

EDA Simulation Library Compile
(Quartus Prime 18.1)r

Search suggestions

P quartus - See web res
£ Quartus - Song

£ quartus download
Documents

Nios Il Documentation (Quartus

D i

Web

More \/

S = )

Feedback

Quartus (Quartus Prime 18.1)

Desktop app

Open
Run as administrator
Open file location
Pin to Start

Pin to taskbar

Uninstall




image10.jpeg
3 Quartus Prime Standard Edition - Uy/CPR E 281 Labs/Lab 1/Lab01/DE2-115 CPRE281 LABO1/DE2-115 CPRE281 LABO
File Edit View Project Assignments Processing Tools Window Help

L] New & /SO TP RO OLOE 9

" Oper ctris0 3] labstep
= S KQWAD = -077TNNOONY
New Project Wiard..

= OpenProfect. cutes
Sove Prject
Close Project

B sae Cutss ¥
Save As. el T L

@ Save All Ctrl+Shift+S. . .:."p_/ 2 ==

File Properties...

Export.. Create Symbol Files for Current File

Convert Programming Files... Create AHDL Include Files for Current File
o Create Verilog Instantiation Template Files for Current Fle.
& PrintPreview Create VHDL Component Declaration Files for Current Fle.

print... Cirlsp Create Design File from Selected Block.

Recererics +  Update Design File from Selected Block.

Recent Projects ,  Create Signal Tap File from Design Instance(s)

M, JBC, SVF, or ISC Fil
= ARTER Create JAM, JBC, SVF, or ISC File.
Create/Update IPS File..

ks Compltation 7 Create Board-Level Boundary-Scan File..

Task 3 Create Top-Level Design File From Pin Planner

» Compile Design




image11.jpeg
3 Quartus Prime Standard Edition - Uy/CPR E 281 Labs/Lab 1/Lab01/DE2-115 CPRE281 LABO1/DE2-115 CPRE281 LABO
File Edit View Project Assignments Processing Tools Window Help

L] New & /SO TP RO OLOE 9

" Oper ctris0 3] labstep
= S KQWAD = -077TNNOONY
New Project Wiard..

= OpenProfect. cutes
Sove Prject
Close Project

B sae Cutss ¥
Save As. el T L

@ Save All Ctrl+Shift+S. . .:."p_/ 2 ==

File Properties...

Export.. Create Symbol Files for Current File

Convert Programming Files... Create AHDL Include Files for Current File
o Create Verilog Instantiation Template Files for Current Fle.
& PrintPreview Create VHDL Component Declaration Files for Current Fle.

print... Cirlsp Create Design File from Selected Block.

Recererics +  Update Design File from Selected Block.

Recent Projects ,  Create Signal Tap File from Design Instance(s)

M, JBC, SVF, or ISC Fil
= ARTER Create JAM, JBC, SVF, or ISC File.
Create/Update IPS File..

ks Compltation 7 Create Board-Level Boundary-Scan File..

Task 3 Create Top-Level Design File From Pin Planner

» Compile Design




image12.png
% Create HDL Design File for Current.. X
File name; [1LABOY /b step1 /labstept.y]
Flle type.

O vioL
® VeriogHoL
Add VHDL Statemens..

Goncel | i




image13.png
% Create HDL Design File for Current.. X
File name; [1LABOY /b step1 /labstept.y]
Flle type.

O vioL
® VeriogHoL
Add VHDL Statemens..

Goncel | i




image14.png
M Modelsim SE-642019.3
File Edit View Comp

Simulate Add Project Tools Layout B

IETEI LI e
| toout fropesign || colmmiayout [11co1ams
*[nane [sttsirpe |ordejeded

Compie Selected

‘Comple Outof Date:
‘Compie Report..
‘Compie Summary..

‘Compie Propertes..





image15.png
M Modelsim SE-642019.3
File Edit View Comp

Simulate Add Project Tools Layout B

IETEI LI e
| toout fropesign || colmmiayout [11co1ams
*[nane [sttsirpe |ordejeded

Compie Selected

‘Comple Outof Date:
‘Compie Report..
‘Compie Summary..

‘Compie Propertes..





image16.png
WA Modelsim SE-64 20193
File Edit View Compile |Simulate| Add Project Tools Layout

#6268 4 oo o [
| SrtSmiaton.. |

Runime Options.

Run
Step
Restar.
Break

End Simulation





image17.png
WA Modelsim SE-64 20193
File Edit View Compile |Simulate| Add Project Tools Layout

#6268 4 oo o [
| SrtSmiaton.. |

Runime Options.

Run
Step
Restar.
Break

End Simulation





image18.png
M Start Simulation X

[*[Name. [Tvee
=ik work Lbrary
lbistept Mode
(sl Foathdb Lbrary
i ieee_env (empty)  Library
(sl infact Library
(il me2 b Library.
i moc_ams (empty)  Library
i miavm Lbrary.
i mtom Lbrary.
i mtPA (empty) Library
i}
-DesgnUnits)
[ork. 1ablscepl
Optmzaton
¥ Enable optimzaton





image19.png
M Start Simulation X

[*[Name. [Tvee
=ik work Lbrary
lbistept Mode
(sl Foathdb Lbrary
i ieee_env (empty)  Library
(sl infact Library
(il me2 b Library.
i moc_ams (empty)  Library
i miavm Lbrary.
i mtom Lbrary.
i mtPA (empty) Library
i}
-DesgnUnits)
[ork. 1ablscepl
Optmzaton
¥ Enable optimzaton





image20.png
M ModelSim SE-64 20202

File Edit View Compile Simulste Add Objects Tools Layout Bookmarks Window Help B ° *
388 (D@0 0-AE|[w B SBERA| W@ e B walUDDRAC ARO[ AT LA 8]

o imiate vl || ooz wl|| 5B 2B- 3| owmus|oaaaf alduip]ieye s

Beoof B s ke || SEASSR]|[L WM [ X0K Bl A

sim - Default Ha x|

linstance [Design unit_[pesign unit type [Top Category

o labistept. labistep1(f... Module DU Instance:

[ #vam_capacity= Capacity Statisties

Select All and press
CTRL+w

!Ih-y [ proect | & sm
R Transarpt
[om:/TabIstepl/A \
lsim: /1ablstep1/3 \
lsim: /Lab1step1/C

o

Ivsm 4>

[project : b1 [Now: 0ns Delta: 0 [sims b 1step1





image21.jpeg




image22.jpeg




image23.png
Object Dedaration

Jebistep1fp the
. febistep1/z e [N
et
view

o

Combine Signas...
Group..
Ungroup





image24.png
Object Dedaration

Jebistep1fp the
. febistep1/z e [N
et
view

o

Combine Signas...
Group..
Ungroup





image25.png
Vi ModelSim SE-64 2019.3
File Edit View Compile Simulate Add Transcript Tools Layout Bookmarks Window Help

B-su28 ihBol|o-ag]w  ajoma | @i # e B[ 100 n 3] ELES
a-5%-3 RIS R
3 sm -Default EER
v|Instance [Design unt_[Designurittype _[Top Category _ [Visbiity _[Total covera
o b bstepiF.. Node DUlsance  taceep

& =vsim_capaciy Capadty Sttitcs tacc-

By [EPoee | Qam

A Transeript
force -freeze sim:/lablstepl/B L'h0 0
force ~freeze sim:/lablstepl/A 1'h0 0
VSIMB> run 100

s 3>

T o e




image26.png
Vi ModelSim SE-64 2019.3
File Edit View Compile Simulate Add Transcript Tools Layout Bookmarks Window Help

B-su28 ihBol|o-ag]w  ajoma | @i # e B[ 100 n 3] ELES
a-5%-3 RIS R
3 sm -Default EER
v|Instance [Design unt_[Designurittype _[Top Category _ [Visbiity _[Total covera
o b bstepiF.. Node DUlsance  taceep

& =vsim_capaciy Capadty Sttitcs tacc-

By [EPoee | Qam

A Transeript
force -freeze sim:/lablstepl/B L'h0 0
force ~freeze sim:/lablstepl/A 1'h0 0
VSIMB> run 100

s 3>

T o e




image1.png
® 0 ® ¥ (hiipsiiviab.ece.iastate.edu < &

a a a

CPRE Labs CprE Labs Virtual EE Labs Physical EE Labs Virtual
Physical





